System Requirements

Color Visions requires the following minimum system configuration:

e A 400 MHz Intel® Pentium®-class or faster processor

¢ Microsoft® Windows® 98, Windows 2000, Windows XP or Windows ME operating system

¢ At least 64 megabytes (MB) of random access memory (RAM)

¢ Atleast 50 MB of available hard disk space; additional disk space is required if you work with many large image files
e A 16 bit (high color) video display card

e A CD-ROM drive

¢ Monitor resolution of 600 x 800 pixels

For achieving the best performance, we recommend the following hardware:

e 128 MB or more of RAM

e A 24 bit (true color) video display card

¢ Monitor resolution greater than 600 x 800 pixels

¢ A Windows-compatible color printer

The performance of Color Visions improves with more RAM, faster CPUs, and faster and larger hard drives.



Adjusting the Monitor's Brightness and Contrast

Most computer monitors have knobs or dials on the front of the monitor that let you adjust the brightness and contrast. For

information on how to adjust the brightness and contrast for your monitor, refer to the manufacturer’s guide that came with your
monitor.

For the best viewing results in Color Visions, turn the monitor’s brightness and contrast controls to maximum.



Adjusting the Monitor's Color Setting

In order for paint colors to display properly, your monitor must support 24-bit or 32-bit true color. Additionally, you must make
sure the True Color setting is selected in the Display Properties dialog box.

If your monitor does not support true color, you can still run Color Visions. However, the displayed colors will not be optimized
for color viewing.

To specify the True Color setting for your monitor:

1 Click the Start button on the Windows taskbar.

2 Point to Settings, and then click Control Panel.

3 Double-click the Display icon.
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The Display Properties dialog box for your monitor appears.
4 Click the Settings tab.
In the Colors box, select True Color (either 24 bit or 32 bit). If you do not select True Color, the paint colors will not display
properly.
If you do not see True Color as an option, try lowering the Screen area by sliding the adjustment to the left. Often times a
lower screen area allows for a higher color setting.

5 Click OK to save your changes and close the dialog box.



If You Have a Roll of Film

Many photographic labs and photo retailers now offer the service of digitizing film at the same time you get the film developed

and printed. You can then copy your images from a disk to your hard drive. These services are available in a few common

formats and the options can sometimes be confusing. Here are a few things to consider when ordering digital files with your

prints:

* Resolution. The resolution represents how much detail will be captured when the film is scanned. A standard resolution for
making good prints is 1024 x 768 pixels. Resolutions less than 1024 x 768 may not yield excellent results when printed; and
higher resolutions may result in very large image files, which can slow your system’s operating speed.

e Media. Be sure that your computer can take the disk that the images are given back to you on. For example, if your
computer does not have a CD-ROM drive, make sure the images are on a diskette.



If You Have Photo Prints

The fastest and least expensive way to get prints digitized is to use a desktop flatbed scanner. These devices work like a
photocopier and produce high-quality digital images. You place the print under a light blocking cover, the system uses light to
scan the print, and the scanner delivers a digital image, which you can then save to your hard drive.

Many fast-copy service companies offer scanning for a fee. Either they will scan the prints for you, or they will let you rent a
workstation that has a scanner attached to it. You can save your scanned images to a disk, take them with you, and copy them
to your hard drive. Using a service company is one way to get digital files from prints without the investment of buying a
scanner.



If You Have Photos on a Disk

If you have a disk with image files on it, the hard part has already been done for you. All you need to do is copy these files to
the hard drive on your computer and open them in Color Visions.



If You Have a Digital Camera

Digital cameras are great tools for quickly and inexpensively getting pictures into your computer. If your camera has several
quality settings, use the highest quality to yield dramatically better results when the pictures are printed.

To get the files from your digital camera to the computer, follow the manufacturer’s specified procedure. You will need to save
the images to your hard drive and open them in Color Visions.

If you have not yet purchased a digital camera, but are considering it, be sure to do some homework before you buy. Cameras
that are similar in price will yield different results. The key things to compare are resolution and price. Typically, more is better
with both of these indicators, and how they relate to image quality.



Photography Tips

To improve the quality of your images as well as your ability to paint them quickly and easily, remember these tips when
photographing your houses:

e Lighting. Try to have the sun behind you or to the side of you when you take a picture. This will insure that the house is well
exposed, and that the sun will not shine in the lens and cause the house to look under exposed.

e Timing. The time of day that you take the picture may change the color of the house. Pictures taken later in the day tend to
be redder and warmer. Pictures taken too early in the day may not have full sun and look underexposed. Pictures taken in
full sun will produce the truest color.

e Fill the Frame. Try to get as close to the subject as possible and fill the image frame with the house. This will produce a
higher resolution file with a digital camera or a scanned print. Higher resolution will yield better detail and better color.

e Unobstructed View. If possible, position the shot so that the picture has as few obstructions as possible. For example,
power lines, trees, and cars all clutter the picture and make more obstacles that you need to paint around when using Color
Visions. Taking a clean picture enables you to work faster and more efficiently.



Opening Color Visions

To open Color Visions, double-click the Color Visions icon on the desktop.
You can also open Color Visions as follows:

1 Click the Start button on the Windows taskbar.

2 Point to Programs, and then point to Color Visions.

3 Click Color Visions.



Closing Color Visions

To exit from Color Visions, select File a Exit.

Or, click the Close box in the upper-right corner of the window.



About the Color Visions Window

The main window gives you access to the menus, tools, and color palettes that you use to paint an image. Take a moment to
get to know the function and location of the major components in the main window.

Menu bar
Toolbar

Paint Surfaces bar
Color palette

Work area

Lists the available menus. Click the menu title to view the commands for that menu.

Gives you quick access to many common commands. All the tools required to paint an image are on
the toolbar.

To learn about a tool’s name and function, place the cursor over the tool without clicking on it. A brief
description of the tool appears in a window.

Lets you select a surface to paint. You can rename the surfaces to suit your personal preferences.

Displays the paint palettes and paint colors that you can apply to an image. There are several paint
palettes.

Represents the space where you view and paint your images.



Basic Procedure to Paint an Image

For this example, let’s assume you want to paint three major areas of the exterior of a house: the body, the trim, and the door.
Each area (or paint surface) will be a different color. After you define the areas that belong to each surface, you can easily
change the paint color of a surface.

Remember that you can use any of the paint and erase tools. Try them all. You will soon find which tools work best for you
and your houses.

To paint a house:
1 Start Color Visions and open an image.
2 Paint the body surface.
* Note that the top-most surface is active when you open an image. Select the name and type in ‘Body’ to change it.

e Use the color palette to select a paint color for the house body. Do not worry about selecting the final paint color now.
You can easily change the paint color at any time. Tip: Painting with a contrasting color helps you see imperfections
easier.

e Use the paint tools to carefully paint all the parts of the house that belong to the body surface. It is important to keep
your trim free of body paint. Subsequent surfaces are easier to paint if you paint the body surface carefully.

¢ Next, erase paint from those areas that are not part of the body surface. For example, use the erase tools to clear body
paint from the trim, the windows, and the door. It will be easy to paint the other surfaces if you paint the house body
carefully.

e You can make changes to the body surface only if you click the corresponding button on the Paint Surface bar. If you
want to paint additional areas of the body or remove paint from an area, be sure to select the Body surface. This rule
holds true for each surface.

3 Paint the trim surface.
¢ Click a different surface button on the Paint Surface bar. Select the name and change it to Trim.
* Repeat the steps used to paint the body surface.

¢ Do not worry about overlapping paint on to the body. By default, Color Visions will not paint over any areas already
defined in another surface. For example, when you work on the trim surface, Color Visions applies paint only to the
areas that are not yet painted. If you want to paint over an existing surface, click on "Protect Each Painted Area" to
deselect that property.

e Be sure to erase paint from those areas that are not part of the trim (for example, the windows and the door). You can
then paint the door as a different surface.

4 Paint the door.
¢ Click a different surface button on the Paint Surface bar. Select the name and change it to accent.
* Repeat the steps used to paint the body surface.

¢ Do not worry about overlapping paint on to the body or the trim. By default, Color Visions will not paint over any areas
already defined in another surface.

Zoom out to view the entire house.
6 Change the color of the entire house.

Select a paint surface and then select a new paint color. You can use the current color palette or select a different palette
from the pop-up menu.

7 Save your work.

Click the Save button on the toolbar to save your image and the painted surfaces. You can open the image at any time and
easily change the paint color of each surface.



Accessing Online Help
To open the online Help, select Help a Help Topics.

You can find and select a help topic by browsing through the contents or searching the index. To print a help topic, click the
Print button at the top of the Help window. For more information on using help and finding help topics, press F1.



Displaying Information About Color Visions

To display the version number, copyright information, and other information select Help a About Color Visions.



Supported Image Formats

You can open the following types of files in Color Visions:

* JPEG (jpg)

¢ Bitmap (.bmp)

If your image file is not in one of these formats, you will not be able to open the file using Color Visions. You can, however,
convert your file into a format that Color Visions supports. Many graphics, photo, and imaging programs have options that let
you export or save the image to one of these formats.

To convert an image to a different format:

1 Open an imaging, paint, or graphics program. For example, click Start on the Windows taskbar. Next, select Programs a
Accessories a Imaging to open the Imaging for Windows application.

Open the image file you want to convert.

3 Look on the File menu for a command that lets you save or export the image into another format (for example, Save As or
Export).

Be sure to specify JPEG or Bitmap as the file format.
5 Save your changes, and then exit from the application.
At this point, you can return to Color Visions and open the file.



Opening an Image

Click the Open button on the toolbar. Or, select File > Open. The Image Browser window appears. Select one of the
options from the tabs along the left side of the window: Open a new photo to paint, Open a photo I’ve painted, or Open a
painted sample photo.

Open a new photo to paint

This allows you to create a new project by selecting an image file from your computer’s directory. Select the drive you need to
browse, and choose an image file. You can preview your images in this window before opening them in Color Visions. When
you first save your work, you are prompted to enter a new name for the Project. Color Visions automatically copies the original
image file, and saves the newly named project files to the My Projects folder. You can continue working on your project at a
later date by clicking on Open a photo I’ve painted. To edit your image prior to painting, click on Edit Image.

Edit Image

Crop allows you to trim unnecessary space from your photo. Click Crop once to get crop marks. Adjust by dragging any side,
or move by clicking inside crop marks and dragging with Hand. Click OK to apply, Cancel Crop to cancel.

Rotate 90 ° turns your photo ninety degrees to the right with each click.

Adjust Color changes the overall brightness, saturation and balance of your photo. Click and drag on each sliding bar, viewing
your changes in the preview window. Select Reset to return to default settings, Cancel to exit Color Adjustment, or OK to
save.

Start Over reverts all edits back to original settings.

Click Open to accept edits and rename your file if needed.  Note that saving the edited image using the same file name will
replace your original picture. It is recommended you create a new file name for your edited image.

Open a photo I’ve painted

Scroll through all projects in the My Projects file by clicking the direction buttons at top left and right. These previews can be
sorted by name or date. You can also rename a file or delete a file. Double click on image to open, or click on the image
once and select Open.

Open a painted sample photo
Scroll through the Sample files by clicking on the direction buttons at top left and right.



Rotating the Image

If an image is not correctly oriented on the screen, use the Edit tools found in the Open a new photo to paint window.




Zooming In and Zooming Out

The Zoom commands let you enlarge or shrink the view of the image on the screen. It is very handy to magnify (zoom in) an
image to paint areas with details or fine edges, and nice to zoom out to view an entire image at once.

Zooming in or out does not affect how the image will print, or how it is saved to disk. Zooming only affects how the image is
displayed on your monitor.

To zoom in:

1 Click the Zoom In button on the toolbar.

2 Click on the center of the area you want to view in detail. Color Visions increases the magnification of the image.

3 Continue to click on the image until you see the detail you want. Use the scroll bars or the Move tool to bring other areas of
the image in to view.

To zoom out:

1 Click the Zoom Out button on the toolbar.

2 Click on the image to zoom out.



Moving the Image View

There may be times when the entire image does not fit in the current window. For example, you may have zoomed in to
magnify your view of the image or you may have reduced the window size. In these cases, use the Move tool to display areas
of the image not visible in the window.

To pan around the current image:

1 Click the Move H"!'r button on the toolbar.

2 Place the hand-shaped cursor anywhere over the image.
3 Drag the cursor to move the image.
You can also use the scroll bars on the bottom and right edges of the window to view other areas of the image.



Displaying Before and After Images

Once you begin to apply paint to an image, you may want to view the original image (no paint), as well as the painted image.
To turn the view of individual paint colors on and off, look for the Show/Hide check box on the Surface Information tab.

¢ To view the original image, click the check box to deselect.
¢ To view the image with your paint applied, click the box again to select.
You can also use the View Original button located at the bottom of the tool bar.

This button will show or hide all surfaces at once.
These commands only change how the image is displayed. They do not affect the image in any way.



About Paint Surfaces

Each paint color in Color Visions is represented by a separate surface. There are seven paint surfaces. The paint surfaces
have several common characteristics:
¢ Asurface can only represent one color.

¢ You need to define the areas of the image that belong to each surface. Once defined, you can change the color in a surface
at any time.

¢ You can save the paint surfaces and edit them later by using the Save or Save As commands.



Selecting a Paint Surface

To select a paint surface, click one of the buttons across the right side of the Color Visions window. The default names are
Surface 1, Surface 2, etc.

You can rename one or more surfaces to suit your personal style or your client’s image.




Renaming a Paint Surface
The default names for the paint surfaces are Surface 1, Surface 2, etc. You can rename one or more surfaces to suit your
personal style or your client’s image. For example, you may want a separate surface for the front door or the shutters.

To rename a paint surface:
1 Place the cursor over one of the surface buttons along the right side of the Color Visions window.
Click the name field on the button you want to rename.

2 Type in the new name.



About the Color Palettes

Color Visions has several different color collections that are grouped into color palettes.

The Palette box on the top of the Color Visions window shows the currently loaded palette. The currently selected paint
number, name, and paint chip appear to the left of the palette. The selected paint color is highlighted in the palette by a yellow
box.

Additionally, you can use the Full Palette button to view all the colors in the palette.



Selecting a Color Palette
Before using a paint tool, be sure to select the palette and paint color you want.
To select a color palette:

1 Click the Palette pop-up menu to the right of the palette area. The menu displays the available palettes.
2 Move the cursor over the name of the palette you want, and then click to load the selected palette.



Viewing all the Colors in a Palette

The Color Visions window displays several colors from the current palette at once. However, many palettes contain more colors
than is practical to display.

To view all the colors in the current palette:

1 Select the palette you want to use.

2 Click the View Full Palette button located to the right of the palette. The colors for the currently selected palette appear in a
separate window.

To close the View Full Palette window, click the Cancel button.



Selecting a Color by its Paint Chip
1 Select the palette you want to use. The Palette area displays several colors.
2 Select a color.
e You can click a paint chip to select that color.
¢ You can use the arrows on either side of the palette to view and select other colors in the current palette.

¢ You can click the View Full Palette button to view all the colors in the current palette. Click a paint chip to select that
color.

When you click a paint chip, notice that Color Visions automatically loads your selection as the active color.
To select another color, simply click the paint chip.
To close the View Full Palette window, click the Cancel button.



Searching for a Paint Color

To search for a color in Color Visions, simply type the name of the paint color in the search box located to the right of the palette
display area. Click search. When the color is found, it will become the active color in the active surface, and the palette will
jump to the correct color chip.

Note: The paint color name must be an exact match to be found.



Painting Helpful Hints

Before you begin to paint an image, check out the following helpful hints:

When you paint the areas that belong to each surface, you may want to use a paint color that is different from the original
color. Do not worry about the final color yet. You can change the color later. Instead, pick a color that you can easily see
as you paint. For example, if the original color is dark brown, select a white or bright yellow to paint with. By using a
contrasting color, you can see what you are doing and notice imperfections. You can apply the correct paint colors when you
finish painting.

Paint the largest surface first. Painting the trim or accent goes faster once the body is done.

Zoom in to paint fine details. It is easier to paint around objects, fixtures, and obstructions if you magnify your view of the
image.

Paint a little over the edges of bushes, trees, and other obstructions. Typically, the overlap looks better than a space with no
color.

Do not be too fussy with your painting. The printed image will be smaller and smoother than the image you see on the
screen.

Paint or erase straight lines by holding down the Ctrl key when you use the Paint with Brush tool or the Erase tool. Making a
straight line is useful for well-defined edges such as trim or porch balusters.




Painting with the Fill tool

The Fill tool is designed to fill irregularly shaped areas automatically. It is useful for painting areas around bushes or trees, as
well as small areas of a certain color. The tool applies paint based on how the image is interpreted.

The fill tool is probably the best tool for painting large, even areas of an image. For large areas, you can also use the Paint by
Selection tool.

To paint using the fill tool:

1 Select the surface you want to paint.

2 Select the desired paint color from the palette.
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3 Click the Fill tool button on the toolbar.

Click on a point that represents the color of the area you want to paint. Color Visions will apply paint to the immediate area
around the selected point. The size of the area depends on the fill distance selected.



Adjusting the Coverage Setting

You can control the sensitivity of the Fill tool by adjusting the Fill Distance setting.

To adjust the Fill Distance setting:

o Click the Fill tool button on the toolbar. Notice that the Fill Distance slider appears on the toolbar.
—

Moving the slider to the left results in painting less area with each click. Moving the slider to the right results in painting more
area with each click.



Painting by Selection

The Paint by Selection tool allows for quick and extremely accurate painting of any area or shape. This tool works with a
connect-the-dots concept.

You define the area by clicking points on the screen. Color Visions will connect a line between the points. You can use up to
500 points to define the area.

The area can be any shape as long as the shape does not intersect itself. In addition, you must close the shape by clicking your
last point next to your first point.

When you close the shape, Color Visions turns each selection point into a movable handle. You can adjust the shape of the
selection before accepting it. To accept the selection, click on the image.

To select and paint an area:

1 Select the surface you want to paint.

2 Select the desired paint color from the palette.

Click the Paint by Selection Bl button on the toolbar.

Be sure that the Paint radio button is selected.

Place the cursor where you want to begin, and then click. A red dot indicates the point you selected.
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Move the cursor to a second point and click again. Color Visions will display a second red dot and draws a dotted line
between the two points.

7 Continue in this fashion until you outline the desired area. Be sure to close the shape by clicking your last point next to your
first point.

Color Visions will recognize when you complete the shape and fill the area with the selected paint color.

Paint by Selection will not, by default, paint over another color or paint surface. Therefore, if you are painting next to an existing
color area, you can overlap the colors and a clean line will result between the two colors.



Painting by Corners

Use the Paint by Corners tool to paint four-sided areas. You draw an X to define the area. This tool is especially useful when
painting large rectangular areas or for quickly painting many small rectangles.

To paint a four-sided area:

1

Select the surface you want to paint.

2 Select the desired paint color from the palette.

3 Click the Paint by Corners button on the toolbar.

4 Be sure that the Paint radio button is selected.

5 Move the cursor to one corner of the area you want to paint.

6 Drag the cursor to the diagonally opposite corner of the box. A green line marks your selection on the screen.

7 Repeat the procedure to define the rest of the box.
When you draw the second line to form an X, Color Visions automatically turns each corner into a movable handle. You can
adjust the shape of the selection before accepting it. To accept the selection, click on the image.

Note

The two lines must intersect for the Paint by Corners tool to work. If the lines do not cross, Color Visions erases both lines
and resets the tool. No painting occurs.



Painting with a Brush

The Brush tool lets you paint freehand. You can select the brush size to use. This tool is very effective for painting small areas
quickly and accurately.

To paint using the brush:

1
2
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Select the surface you want to paint.
Select the desired paint color from the palette.

Click the Brush
Be sure that the Paint radio button is selected.

button on the toolbar.

Adjust the brush size, if necessary.
Move the cursor to the area you want to paint.
Drag the paintbrush. It’s that easy.

To paint straight lines and edges, hold down the Ctrl key while using the paintbrush.

with straight, well-defined edges such as window trim or porch balusters.

Painting a straight line is useful for areas



Setting the Brush Size

You can control the size of the paintbrush with the Brush Size setting.
Note that the Brush Size setting controls the size of the Paint with Brush tool as well as the size of the Erase tool.

To adjust the brush size:
¢ Click the Brush button on the toolbar. Notice that the Brush Size slider, along with the current brush size, appear on the
toolbar. The size of the ball changes to represent the selected size of the paintbrush. The change in size takes effect

immediately.

Moving the slider to the left makes the brush smaller, therefore painting less area with each click and drag. Moving the slider to
the right makes the brush bigger, therefore painting more area with each click and drag.

The new setting does not affect any areas you already painted. Color Visions will use the new setting the next time you use the
paintbrush or the erase tool. It continues to use this setting until you change it again.



Erasing by Selection

The Erase by Selection tool removes paint from an area or shape you define in the selected paint layer. This tool works with a
connect-the-dots concept.

You define the area by clicking points on the screen. Color Visions will connect a line between the points. You can use up to
500 points to define the area.

The area can be any shape as long as the shape does not intersect itself. In addition, you must close the shape by clicking your
last point next to your first point.

When you close the shape, Color Visions turns each selection point into a movable handle. You can adjust the shape of the
selection before accepting it. To accept the selection, click on the image.

To remove paint from a specified area:

1 Select the layer you want to remove paint from.
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Click the Erase by Selection .
Be sure that the Erase radio button is selected.

button on the toolbar.

Place the cursor where you want to begin, and then click. A red dot indicates the point you selected.
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Move the cursor to a second point and click again. Color Visions will display a second red dot and draw a dotted line
between the two points.

6 Continue in this fashion until you outline the desired area. Be sure to close the shape by clicking your last point next to your
first point.

Color Visions recognizes when you complete the shape. It removes the paint from the defined area and restores the original
color.



Erasing by Corners

Use the Erase by Corners tool to remove paint from four-sided areas. You draw an X to define the area. This tool is especially
useful when removing paint from windows, doors, and trim, as well as cleaning up edges that you may have over painted.

To erase paint from a four-sided area:

1
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Select the layer you want to remove paint from.

Click the Erase by Corners button on the toolbar.

Be sure that the Erase radio button is selected.

Move the cursor to one corner of the area you want to erase.

Drag the cursor to the diagonally opposite corner of the box. A red line marks your selection on the screen.
Repeat the procedure to define the rest of the box.

When you draw the second line to form an X, Color Visions automatically turns each corner into a movable handle. You can
adjust the shape of the selection before accepting it. To accept the selection, click on the image.

Note

The two lines must intersect for the Erase by Corners tool to work. If the lines do not cross, Color Visions erases both lines
and resets the tool. It does not remove any paint.



Erasing

The Erase tool lets you erase freehand. You can select the eraser size to use. This tool is very effective for erasing small
areas quickly and accurately. When you erase a color from an area, Color Visions reveals the original picture beneath. You
can paint the area again.

To erase:

1 Select the surface you want to remove paint from.

Click the Erase button on the toolbar.
Adjust the eraser size, if necessary.
Move the cursor to the area you want to erase.
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Drag the mouse. It’s that easy.

To erase straight lines and edges, hold down the Ctrl key while using the erase brush. Erasing a straight line is useful for
areas with straight, well-defined edges such as window trim or porch balusters.



Setting the Eraser Brush Size

You can control the size of the Erase tool with the Brush Size setting.
Note that the Brush Size setting controls the size of the Erase tool as well as the size of the Paint with Brush tool.

To adjust the eraser brush size:
¢ Click the Erase button on the toolbar. Notice that the Brush Size slider, along with the current brush size, appear on the
toolbar. The size of the ball changes to represent the selected size of the brush. The change in size takes effect

immediateli.

Moving the slider to the left makes the brush smaller, therefore erasing less area with each click and drag. Moving the slider to
the right makes the brush bigger, therefore erasing more area with each click and drag.

The new setting does not affect any areas that you already erased. Color Visions will use the new setting the next time you use
the erase tool or the paintbrush tool. It continues to use this setting until you change it again.



Undoing Your Last Change

The Undo command deletes the last single paint or erase action you performed. Undo is useful if you make a mistake (oops!)
or simply do not like the results of the last change you made.

To undo your last change, click the Undo button on the toolbar. This button is only shown when you are able to use it.



Removing All Paint from a Surface

There may be times when you want to remove all the paint from a surface and start over again. The X button on the Surface
information tab removes paint from the currently selected layer.

Note
Be carefull These commands delete all your painting work for the selected surface(s). You cannot undo these actions.

To remove paint from the currently selected surface:
1 Select a paint surface by clicking one of the Paintable Area buttons to the right of the Color Visions window.

2 Click on the X button.



Reverting to the Last Saved Image

The Revert command returns to the previously saved version of the current file. The command deletes all changes made to the
image since you last saved the file. These changes include painting, erasing, editing the client information.

The Revert command is useful if you do not like your most recent changes and would like to begin again. Use the Revert
command only when you want to lose all information associated with the file. Use the Undo command if you want to undo your

last action only.

To revert to the previously saved version of the current file:

1 Select File a Revert. Color Visions will prompt you for confirmation before continuing.
2 Click Yes.



Saving Your Work
Use the Save command to save your painting work at any time. This command does not change your original image.
&
To save your painting work, click the Save M=l button on the toolbar. Or, select File & Save.
If you want to save your project under a different name, select File a Save As.



Exporting Images

When you finish painting a house, you use the Save command to save your changes. You may also want to export the painted
image to a standard image format.

An exported image provides a convenient way to electronically show the finished results to your clients. You can easily attach
the file to an e-mail or post the file on a web page that can be viewed remotely by your client. Because the file is in JPEG
format, your clients can open, view, and print the image using any application that supports JPEG. They do not need the Color
Visions application.

e The Export command saves an image of the house as you painted it with the colors you selected. The Export command
does not save the paint surfaces. When you open the file later, the painting surfaces will not be active.

Color Visions will save all exported images as JPEG files.

To export an image:

1 Select File a Export.

2  Browse to the folder that you want to save the file in.

3 Click the New Folder button if you want to create a new folder for your image.
4  Click Save to export the image.



Choosing the Best Paper

Today’s color printers accept a variety of papers and deliver a variety of quality levels. Print quality is almost entirely dependent
on the paper that the image is printed on. With that in mind, you should use the finest paper available to achieve the highest
quality output.

For ink jet printers, papers labeled Photo Quality will deliver remarkably better images than regular office copy paper. Matte
Finish typically provides more realistic color reproduction than Glossy Finish. Matte Finish is recommended. As a rule of
thumb, the more the paper costs, the better it will print. If a paper is available from your printer manufacturer, try it.

Selecting the right paper is important to print quality. It is equally important to make sure the printer settings are correct. Every
printer has software, called the printer driver, that lets you define properties for your printer. These properties include print
mode, paper type, ink color, print resolution, and speed.



Viewing Prints in the Best Light

Just as the color of a house looks different at different times of the day, the color prints from Color Visions look different in
different lighting conditions. For example:

¢ Fluorescent lights will make your images appear greenish.
¢ Incandescent lights will make your images appear redder, or warmer.

If you are producing work for a client, try to work, or at least view the material, in lighting similar to the lighting your clients will
use when viewing the prints.

Viewing prints by a window with natural light, or even outside is the best possible situation. Remember: Your clients will usually
see the color of their house in natural light.



Why Enter Contractor and Client Information?

Before printing any images, you may want to enter the name, address, and phone number for the client and the contractor. You
can also enter notes or comments about a job.

Color Visions will include the contractor and client information on the printed page. By entering contractor and client
information, you can clearly state who provided the service of painting the digital image, as well as show clients that a
professional service was customized and provided just for them.



Entering Contractor Information

The contractor information is usually the same for each job. Therefore, you need to enter the contractor information only once.
Color Visions will use the specified information for every image. If your company name or address changes, you can update the
information.

To enter contractor information:
1 Select File a Set Contractor Information. The Contractor Information dialog box appears.
2 Type information into whatever fields you want.

3 Click OK when you are finished.

Color Visions will use this information for all images. To make changes, open the dialog box again and enter the new
information.



Entering Client Information

You can enter client information and job-specific notes for every image. Color Visions will include the client information on the
printed page and save the data with the image file.

To enter client information:

1 Select File a Set Client Info. The Client Information dialog box appears.

2 Type information into whatever fields you want.

3 Click OK when you are finished.
Color Visions will save this client information with this particular image. To make changes, open the dialog box again and
enter the new information.
Remember that you must enter the client information each time you open a new image if you want the data to print with the
image.



Entering Notes About a Painting Job

In addition to the name, address, and phone number fields, the Client Information dialog box has a Notes field. The Notes field
is a convenient place to enter comments about the painting job. For example, you may want to specify items that you discussed
with the client, post a possible schedule, or enter reminders to yourself. Color Visions will include your notes on the printed
page.




Looking at a Print Preview

To display an image of what the printed output will look like, select File a Print. You can check the position and content of the
page before any printing takes place.



Printing an Image

Color Visions outputs an 8.5" x 11" full-page printout with the following information:
¢ The original image before it was digitally painted.

¢ An image of the house after it was digitally painted.

¢ The client's name, address, and phone number, if specified.

e The contractor's name, address, and phone number, if specified.

e Any notes or comments about the painting job, if specified.

* The paint name and number used for each surface.

To print an image:

1 Click the Print
2 Be sure that you

button on the toolbar. Or, select File a Print.

. Select your printer

. Check the properties for your printer

. Enter the number of copies you want to print
3 Click OK to print the page.

Note that the printout, by default, includes an image of the house before it was painted and an image of the house after it was
digitally painted.

Disclaimer

The images printed with Color Visions approximate as closely as possible the actual paint color. However, color appearance
may vary by degree of gloss, texture, lighting, and method of application, as well as by exposure to heat and light rays.
Variations in monitor and printer settings may also affect color consistency and accuracy.

See Also
Choosing the best paper

Viewing prints in the best light




Registering Color Visions
Why is it important to register your Color Visions software? As a registered user, you will receive direct access to our trained
team of technical support specialists. Registration also provides you with timely access to the latest product updates,
releases, and services.

Look for the serial number printed on the back of the CD jewel case. Please write this number down in a safe place. You will
need the serial number to register your software.

To find the serial number once you install and run Color Visions, select Help > About Color Visions. The screen displays the
number.

To register your copy of the Porter Paints Design Spectrum Color Visions, visit the online registration page at
www.eisoftwareinc.com/support/PORTER/reg.asp




Contacting Technical Support

If you have questions about the Color Visions software, check the information in this help document as well as the online help
site. If you still need assistance, contact Technical Support.

Support Web Site: www.eisoftwareinc.com/support/PORTER

Telephone: 1 (800) 405-5104
Telephone support is available from 9:00 am to 4:00 pm EST, Monday though Friday.



Sample Images and Saving

Color Visions only allows you to save Sample Images with the Save As command. Sample Images are always kept in their
original format. While working on a Sample Image, the Save button in the toolbar is disabled and grayed out. You may save
any changes to a Sample Image by selecting File > Save As.

If you would like to make new versions of the images with different colors for use in another application you can Export the
painted file for later use. You can also print the Sample Images with different color schemes applied.



Starting a New Project

To start a new project, select File > Open. This will open the Open Project window. From here you can open a new image,
and image you have already worked on, or a sample image.

To finish a project you can Save your file, and then exit the application. You can also select File > Exit. You will be prompted
to name the project. After naming the project you can exit the application.



Ending a Project
When you have completed painting your project, you should save your work. To finish a project you can Save your file, and
then exit the application. You can also select File > Exit. You will be prompted to name the project. After naming the
project you can exit the application.



The Favorites Palette

The Favorites palette is a place where you can store frequently used colors for quick and easy retrieval. You can add any
color from another palette to your Favorites palette.

To add a color to the Favorites palette:
1 Select the color in its native palette.
2  Click ‘add to favorite colors’ located above the palette.

To view the Favorites palette:
1 Click the palette pop-up menu.
2 Move the cursor over ‘My Favorite Colors’, and then click to display the palette.

To remove a color from the Favorites palette:
1 Display the Favorites palette.
2  Select the color you want to remove.
3  Click ‘Remove from favorite colors’ located at the top of the palette.



PaintSelect ESP

Running Paint Select ESP
The application Paint Select ESP is included on the PPG Color Visions CD. If you would like to install Paint Select ESP, in
Windows Explorer open the folder titled PaintSelectESP, located on the Color Visions CD.

From this folder select Autsetup.exe. Follow the prompts to install the software to your local computer.

ei software does not make or support the Paint Select ESP application. If you have questions regarding the software, please
contact PPG directly.
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